Next Generation Solenoid Driver

Evaluation Kit User Manual

About this document

This document explains how the Evaluation Kit for the NextGen Solenoid Driver ICs TLE92464ED and TLE92466ED are taking into operation. The required hardware and software components for the evaluation of the Next Gen Solenoid Driver IC TLE92464ED/TLE92466ED are documented. See the TLE92464ED/TLE92466ED datasheet for a detailed description of the device.

Note: All references of the TLE92464ED Evaluation board within this document are also valid for TLE92466ED Evaluation board.

Intended audience

This document is intended for anyone who uses the Next Gen Solenoid Driver Evaluation Kit.

Table of contents

About this document ........................................................................................................................................... 1
Table of contents .............................................................................................................................................. 1

1 Hardware .................................................................................................................................................. 2
  1.1 Eval PCB .............................................................................................................................................. 2
  1.1.1 Connector Interface for Arduino .................................................................................................... 4
  1.1.2 Jumper Options ........................................................................................................................... 7
  1.1.3 LEDs ............................................................................................................................................ 7
  1.2 Connection PCB .................................................................................................................................. 7
  1.2.1 Connector Interface for TriBoard TC277 ...................................................................................... 8
  1.2.2 Jumper Options ........................................................................................................................... 9
  1.3 Version S setup .................................................................................................................................. 9
  1.4 Version L setup .................................................................................................................................. 11
  1.5 Schematics ......................................................................................................................................... 11

2 Software .................................................................................................................................................. 22
  2.1 Flashing/Updating Aurix TC277 Software ......................................................................................... 22
  2.2 Flashing/Updating XMC Software ................................................................................................... 22
  2.3 XMC for Arduino IDE ....................................................................................................................... 23
  2.4 Graphical User Interface (GUI) ......................................................................................................... 24
    2.4.1 Main Window ........................................................................................................................... 24
    2.4.2 Evaluation Board Tabs .............................................................................................................. 25
  2.5 Information on the GUI communication interface ............................................................................ 27
    2.5.1 List of Commands .................................................................................................................... 27

Revision history .............................................................................................................................................. 30
1 Hardware

The Evaluation Kit is available in two versions. Version S includes an Eval PCB with an Arduino form-factor. It supports a quick and easy plug & play evaluation of the Next Gen Solenoid Driver. Version L includes the Eval PCB and an additional Connection PCB. The Version L is the more advanced setup option for detailed laboratory measurements.

1.1 Eval PCB

The Version S includes the Evaluation PCB with the Next Gen Solenoid Driver TLE92464ED and all required external components on it. The Evaluation PCB is designed on an Arduino Formfactor which makes it controllable by all Arduino compatible microcontroller boards, e.g.:

- Infineon XMC1100 Boot Kit
- Infineon XMC4700 Relax Kit
- Aurix ShieldBuddy TC275
- Arduino Uno

Figure 1/Figure 2 give an overview of the component blocks on the Evaluation PCB for TLE92464ED/TLE92466ED. The IC itself is powered with 5V via the microcontroller board (version S) or the Connection PCB (version L), respectively. The load supply voltage VBAT which is available at the output channel connectors can be applied via the VBAT connector in version S (close JP1 – Pin Header, refer Jumper Options). In version L the VBAT level is supplied via the Connection PCB. The IC is clocked by an external rectangular 2 MHz oscillator. Another external clock source (e.g. microcontroller) can be selected via the ohmic Jumper (R12/R13). The SPI signals, the ENABLE signal and the RESETN signal must be provided by the microcontroller to enable a successful communication between the microcontroller and the TLE92464ED. The FAULTN and the DRVx signal are only necessary if the according features are used. The status LEDs indicate whether the corresponding function is active (glowing) or not. The reset source DIP switch enables the selection of different pins for the RESETN signal. This option is only needed for the operation with multiply Evaluation PCBs.
Figure 2  Functional component blocks on the Evaluation PCB – TLE92466ED
1.1.1 Connector Interface for Arduino

The Connector placement of the Evaluation PCB is compliant with the Arduino form-factor. The pinouts are listed below.

![Figure 3 Power Connector X1](image)

<table>
<thead>
<tr>
<th>Pin no.</th>
<th>Arduino™ Signal Name</th>
<th>Evaluation PCB Signal Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>IOREF</td>
<td>VIO</td>
<td>Voltage level for the SPI-MISO-Signal (3V3 or 5V)</td>
</tr>
<tr>
<td>3</td>
<td>RESET</td>
<td>RESET#</td>
<td>Reset signal (low active) for the TLE92464ED. All Reset signal source DIP-switches should be open.</td>
</tr>
<tr>
<td>4</td>
<td>3.3V</td>
<td>+3.3V</td>
<td>3V3 volt supply</td>
</tr>
<tr>
<td>5</td>
<td>5V</td>
<td>+5V</td>
<td>5V volt supply</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>8</td>
<td>VIN</td>
<td>VBAT</td>
<td>Voltage Level (usually 12V) applied on the VBAT-Connector to supply the Arduino board</td>
</tr>
</tbody>
</table>
### Communication Interface Connector X3

#### Table 2

<table>
<thead>
<tr>
<th>Pin no.</th>
<th>Arduino™ Signal Name</th>
<th>Evaluation PCB Signal Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IO8</td>
<td>CS1#</td>
<td>SPI Chipselect signal for multiply Evaluation PCB use. Note: R7 must be assembled.</td>
</tr>
<tr>
<td>2</td>
<td>IO9</td>
<td>MC-CLK</td>
<td>TLE92464ED Clock input signal from the microcontroller. Note: R13 must be assembled and R12 disassembled.</td>
</tr>
<tr>
<td>3</td>
<td>IO10</td>
<td>CS0#</td>
<td>SPI Chipselect signal</td>
</tr>
<tr>
<td>4</td>
<td>IO11</td>
<td>MOSI</td>
<td>SPI Master Out Slave In</td>
</tr>
<tr>
<td>5</td>
<td>IO12</td>
<td>MISO</td>
<td>SPI Master In Slave Out</td>
</tr>
<tr>
<td>6</td>
<td>IO13</td>
<td>SCLK</td>
<td>SPI Clock (max. 8 MHz)</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>8</td>
<td>AREF</td>
<td>AREF</td>
<td>Analog reference Pin - not connected</td>
</tr>
<tr>
<td>9</td>
<td>SDA</td>
<td>SDA</td>
<td>I2C SDA Pin – close DIP switch 2 to use it as reset signal source (digital IO)</td>
</tr>
<tr>
<td>10</td>
<td>SCL</td>
<td>SCL</td>
<td>I2C SCL Pin – close DIP switch 1 to use it as reset signal source (digital IO)</td>
</tr>
</tbody>
</table>
Table 3  Digital IO Connector X5

<table>
<thead>
<tr>
<th>Pin no.</th>
<th>Arudino™ Signal Name</th>
<th>Evaluation PCB Signal Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IO0</td>
<td>RX</td>
<td>UART Receive – close DIP switch 4 to use it as reset signal source (digital IO)</td>
</tr>
<tr>
<td>2</td>
<td>IO1</td>
<td>TX</td>
<td>UART Transmit – close DIP switch 3 to use it as reset signal source (digital IO)</td>
</tr>
<tr>
<td>3</td>
<td>IO2</td>
<td>EN</td>
<td>TLE92464ED Enable Input Pin</td>
</tr>
<tr>
<td>4</td>
<td>IO3</td>
<td>FAULT#</td>
<td>TLE92464ED Fault Output Pin</td>
</tr>
<tr>
<td>5</td>
<td>IO4</td>
<td>DRV0</td>
<td>TLE92464ED DRV0 Pin for direct drive mode of Channel 0</td>
</tr>
<tr>
<td>6</td>
<td>IO5</td>
<td>DRV1</td>
<td>TLE92464ED DRV1 Pin for direct drive mode of Channel 1</td>
</tr>
<tr>
<td>7</td>
<td>IO6</td>
<td>DRV2</td>
<td>TLE92464ED DRV2 Pin for direct drive mode of Channel 2</td>
</tr>
<tr>
<td>8</td>
<td>IO7</td>
<td>DRV3</td>
<td>TLE92464ED DRV3 Pin for direct drive mode of Channel 3</td>
</tr>
</tbody>
</table>

Table 4  Analog Connector X4

<table>
<thead>
<tr>
<th>Pin no.</th>
<th>Arudino™ Signal Name</th>
<th>Evaluation PCB Signal Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AD0</td>
<td>X4.1</td>
<td>Not connected</td>
</tr>
<tr>
<td>2</td>
<td>AD1</td>
<td>X4.2</td>
<td>Not connected</td>
</tr>
<tr>
<td>3</td>
<td>AD2</td>
<td>X4.3</td>
<td>Not connected</td>
</tr>
<tr>
<td>4</td>
<td>AD3</td>
<td>X4.4</td>
<td>Not connected</td>
</tr>
</tbody>
</table>
1.1.2 Jumper Options

On the Evaluation PCB are various configuration options available to enable all features in both versions (S and L) and to test the chip in different conditions. The jumper options are described in the table below.

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Jumper Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IC Clock signal source</td>
<td>R12 (default)</td>
<td>External 2MHz Oscillator source</td>
</tr>
<tr>
<td></td>
<td>R13</td>
<td>Microcontroller Clock source via Connector Pin MC-CLK (e.g. PWM signal)</td>
</tr>
<tr>
<td>Chip select signal source</td>
<td>R11 (default)</td>
<td>SPI chip select via Connector Pin CS0#</td>
</tr>
<tr>
<td></td>
<td>R7</td>
<td>SPI chip select via Connector Pin CS1#</td>
</tr>
<tr>
<td>Reset signal source</td>
<td>DIP Switches open (default)</td>
<td>RESET# Pin as Reset signal source</td>
</tr>
<tr>
<td></td>
<td>DIP Switch 1 closed</td>
<td>SCL Pin as Reset signal source</td>
</tr>
<tr>
<td></td>
<td>DIP Switch 2 closed</td>
<td>SDA Pin as Reset signal source</td>
</tr>
<tr>
<td></td>
<td>DIP Switch 3 closed</td>
<td>TX Pin as Reset signal source</td>
</tr>
<tr>
<td></td>
<td>DIP Switch 4 closed</td>
<td>RX Pin as Reset signal source</td>
</tr>
<tr>
<td>VBAT supply</td>
<td>Pin header JP1 closed (default)</td>
<td>Supply Output Connector with VBAT voltage level via VBAT-EXT Connector</td>
</tr>
<tr>
<td></td>
<td>Pin header JP1 open</td>
<td>Evaluation PCB Output Connectors are supplied via the Connection PCB</td>
</tr>
</tbody>
</table>

Note: Open for use with Connection PCB

1.1.3 LEDs

The Eval PCB has five LEDs which indicate the status and operating conditions of the IC. The meaning of the status LEDs is described below.

<table>
<thead>
<tr>
<th>LED designation</th>
<th>TLE92464ED Pin designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAULT</td>
<td>FAULTN (low active)</td>
<td>Glows if the IC detected a fault condition</td>
</tr>
<tr>
<td>ENABLE</td>
<td>EN (high active)</td>
<td>Glows if the IC is enabled</td>
</tr>
<tr>
<td>RESET</td>
<td>RESN (low active)</td>
<td>Glows if the IC is in reset state</td>
</tr>
<tr>
<td>VIO 3.3V</td>
<td>VIO</td>
<td>Glows if the VIO Pin is connected to 3.3V (voltage level for SPI MISO Pin)</td>
</tr>
<tr>
<td>VIO 5V</td>
<td>VIO</td>
<td>Glows if the VIO Pin is connected to 5V (voltage level for SPI MISO Pin)</td>
</tr>
</tbody>
</table>

1.2 Connection PCB

The version L includes the Evaluation PCB, the Connection PCB and an Infineon Aurix TriBoard TC277. The Connection PCB supports the evaluation of up to three Evaluation PCBs in parallel. Furthermore it provides advanced measurement options and one high side switch for each Evaluation PCB. The control unit for version...
L is intended to be an Infineon Aurix TriBoard TC277 which can be plugged on the Connection PCB. Figure 1 gives an overview of the Connection PCB.

**Note:** For use of the Connection PCB please open the Pin header Jumper on the Evaluation PCB (see 1.1.2)

![Connection PCB](image)

**Figure 7** Connection PCB without TriBoard and Eval PCB

### 1.2.1 Connector Interface for TriBoard TC277

All three Evaluation PCB slots are connected to the TriBoard TC277 microcontroller board to enable the feature set of the Evaluation PCB. One SPI interface with three different Chip Select signals is used for the communication between the microcontroller and the Evaluation PCBs. Each digital IO signal (Enable, Reset, Fault, high side FET on/off, direct drive pins) is connected to an individual digital IO pin.

**Note:** For detailed pin assignment documentation see the Connection PCB schematic.

An individual Evaluation PCB reset can be triggered by software. The corresponding digital IO pin must be set to low. A reset signal for all three Evaluation PCB can be trigger via the PORST# signal of the TriBoard either by software or the corresponding button. Unused common signals (e.g. UART, I2C) are kept available for any extension.
1.2.2 Jumper Options

The Connection PCB can be configured via some Jumpers which are described below.

Table 7 Jumper Options

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Jumper Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High side FET</td>
<td>JP6x</td>
<td>Close for use without high side FET</td>
</tr>
<tr>
<td>High side FET controlling</td>
<td>JP5x 3-4 “EN#” (default)</td>
<td>High side FET is controlled by the microcontroller via two digital IO-Pins (active on low level)</td>
</tr>
<tr>
<td></td>
<td>JP5x 1-2 “VBAT”</td>
<td>Deactivates the high side FET (continuous off)</td>
</tr>
<tr>
<td></td>
<td>JP5x 5-6 “GND”</td>
<td>Activates the high side FET (continuous on)</td>
</tr>
<tr>
<td>Direct Drive Pins</td>
<td>JP1x, JP2x, JP3x, JP4x 3-4 “DRVx” (default)</td>
<td>Direct drive Pins are controlled by the microcontroller</td>
</tr>
<tr>
<td></td>
<td>JP1x, JP2x, JP3x, JP4x 1-2 “VIO”</td>
<td>Set direct drive pins to VIO level (5V default).</td>
</tr>
<tr>
<td></td>
<td>JP1x, JP2x, JP3x, JP4x 5-6 “GND”</td>
<td>Set direct drive pins to GND level.</td>
</tr>
</tbody>
</table>

1.3 Version S setup

In Figure 8 a basic setup for the Version S of the Evaluation Kit is shown. On the external supply connector the voltage for $V_{bat}$ in the range of 5.5V up to 40V can be provided. The output channels are supplied with $V_{bat}$ by closing the Jumper JP1 (refer Table 5). If the XMC1100 microcontroller is flashed with the Commando Interpreter software the TLE92464ED can be controlled via the USB connection by the PC. The USB connector can also be used to flash and debug own embedded software. It is recommended to use the DAVE IDE for programming XMC microcontrollers ([https://www.infineon.com/cms/de/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-registered-cortex-registered-m/dave-version-4-free-development-platform-for-code-generation/channel.html?channel=db3a30433580b3710139f8ee6963814](https://www.infineon.com/cms/de/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-registered-cortex-registered-m/dave-version-4-free-development-platform-for-code-generation/channel.html?channel=db3a30433580b3710139f8ee6963814)).
**Figure 8** Setup example for Version S (XMC1100 Boot Kit with TLE92464ED Evaluation board)

**Figure 9** XMC4700 considerations – Evalboard setup is identical to XMC110, but the IOREF jumper on the XMC board needs to be closed
1.4 Version L setup

In Figure 10 a Version L setup with one Eval PCB and a TC277 microcontroller TriBoard is shown. The main voltage input is connected to the upper middle connectors and supplies the whole board setup inclusive loads. Take care on maximum current ratings. In case of using Eval PCBs in parallel supply the board via all four supply connectors (two red, two black). Each Eval PCB slot has its own SPI chip select signal to support an individual communication. The slots are named alphabetic. In Figure 10 a solenoid is connected to Channel 0 at slot A of the connection PCB. If the TC277 microcontroller is flashed with the Commando Interpreter software the TLE92464ED can be controlled via the USB connection by the PC. The USB connector can also be used to flash and debug own embedded software. It is recommended to use the TriCore Entry Toolchain (https://www.infineon.com/cms/de/product/microcontroller/32-bit-tricore-tm-microcontroller/tricore-tm-development-tools-software-and-kits/free-tricore-entry-tool-chain/channel.html?channel=db3a304344134c7a014420d628fa76ec).

Figure 10  Setup example for Version L with a TC277 TriBoard

1.5 Schematics

This chapter contains the schematics of the Evaluation PCBs and the Connection PCB.
Figure 12  Schematic of the TLE92466ED Evaluation PCB
Figure 13  Schematic of the Connection PCB - Overview
Figure 14  Schematic of Connection PCB – TriBoard Connector 1
Figure 15  Schematic of Connection PCB – TriBoard Connector 2
Figure 16  Schematic of Connection PCB – Evaluation PCB Connectors
Figure 17  Schematic Connection PCB – Power supply
Figure 18  Layout Evaluation-PCB – TLE92464ED
Figure 19  Layout Evaluation-PCB – TLE92466ED
Figure 20  Layout Connection PCB
2 Software

Before using the GUI, the selected microcontroller must be flashed with the communication firmware. The sections Flashing/Updating Aurix TC277 Software and Flashing/Updating XMC Software explaining the steps to be taken for a successful flashing of the microcontroller GUI interface software.

2.1 Flashing/Updating Aurix TC277 Software

Following steps should be taken to flash the Aurix TC277 Triboard and enable a communication with the GUI:

- Plug the TriBoard and the Evaluation PCB on the Connection PCB
- Install the Infineon DAS-Tool inclusive drivers on your computer (https://www.infineon.com/cms/en/product/promopages/das)
- Supply and connect the Evaluation board
- Select the Target TriBoard (Target -> Change -> new)
- Select the appropriate Triboard (Tricore Aurix -> Application Kits (DAS) -> Application Kit with TC277T D-Step (DAS))
- Click the Connect button in Memtool and load the provided HEX file via the button “Open file”
- Click “Select All”, Click “Add Sel.”, Click “Program all”
- A small window should pop up and program the Aurix. The “result” should show “success”

Figure 21 Successful flashing setup of Memtool

2.2 Flashing/Updating XMC Software

The Evaluation board can be fully controlled via the GUI by following Infineon XMC board

- XMC1100 Boot Kit (SP001069652)
- XMC4700 Relax Kit (SP001427974) - recommended
A full GUI support for the Version S setup presupposes the according microcontroller firmware for correct interaction. The according Firmware for the XMC1100 and XMC4700 is provided as .hex file in the GUI folder under “XMC FirmwareFiles”. The flashing of the XMC microcontroller is explained by means of XMC1100 (please refer XMC4700 RelaxKit “Getting started”-guide).

Flashing XMC4700 Microcontroller is done via the J-Link Flash lite which can be obtained from the segger website (https://www.segger.com/products/debug-probes/j-link/technology/flash-download/).

Upon opening JLink Flash lite, this screen pops up:

![Figure 22 Segger J-Flash Lite start up – select microcontroller](image)

When executing J-flash lite, select the XMC 4700 microcontroller as shown in Figure 22. By clicking ok, the flasher tool pops up where the downloaded firmware needs to be selected in the section “Data File”. If the Relax Kit is connected via USB, the firmware can be flashed onto the microcontroller and the J-falsher should acknowledge the successful flash operation as shown in Figure 23.

![Figure 23 Successful flashing of the XMC4700 microcontroller](image)

2.3 XMC for Arduino IDE

Own software projects can easily be written and updated to the XMC microcontroller boards.
• Install Arduino IDE
• Install Infineon’s XMC Microcontroller Boards for Arduino: [https://github.com/Infineon/XMC-for-Arduino](https://github.com/Infineon/XMC-for-Arduino)
• Create your own SW Project
• Compile the project (Sketch -> Verify/Compile)
• Connect the XMC1100 Boot kit/XMC4700 Relax Kit via USB and upload the compiled project (Sketch -> Upload)

2.4 Graphical User Interface (GUI)

The GUI can be used either with an XMC or TriBoard (incl. Connection PCB) setup. Both setups require a microcontroller software for the communication with the GUI. The steps to flash the used microcontroller with the firmware is explained in the previous sections.

Following steps should be taken to start before starting the GUI (see also “getting started”):

• XMC: Plug a 12V supply into VBAT_EXT and GND and connect the XMC board via the USB connector to the computer (see Figure 8)
• TriBoard:
  o Please install the DAS tool (see 2.1)
  o Plug a 12V supply into the VBAT_EXT and GND Connectors on the Connection PCB and connect the TriBoard via the USB connector with your computer (see Figure 10)
• Start the GUI and connect to the right COM Port
• When setting the EN Checkbox the EN-LED on the Eval PCB should glow and the communication to the Solenoid Driver IC is fully operational.

2.4.1 Main Window

After starting the GUI a dialog window will pop up (Figure 24). From the first drop-down menu, select the connection PCB or the microcontroller board (XMC1100 or XMC4700) which is being used to interface with the evaluation board. Based on the first selection of either a common connection PCB or XMC microcontroller board, it is possible to test either three or one evaluation board respectively. If the common connection PCB was first chosen, the three IC evaluation boards being used should be selected for each slot from the three subsequent drop-down menus. Alternatively, if a XMC is the tool of choice, then the user can only an evaluation kit for Slot A in the dialog window shown in Figure 24.

![Figure 24 Slot selection for the Connection PCB](Image)
After selecting the connection-PCB or microcontroller board from the first drop-down menu, a prompt pops up for selecting the COM port for the USB-Serial interface. Locate the correct port in the ‘Ports’ section of the Device Manager on your PC’s Control Panel.

![COM port selection](image)

**Figure 25** COM port selection

Once the correct COM port is identified, the GUI starts up in its default state, see Figure 26.

![Main window overview](image)

**Figure 26** Main window overview

The Connect button in the top left corner opens the slot-selection menu. Next to it is the View menu which offers different layout options for the main window, such as hiding certain widgets or tabs, as well as saving the layout preferences. The bottom left corner has three buttons for switching across the three tabs corresponding to the three evaluation boards.

One useful feature of this GUI is its ability to load and run a user-written macro sequence, as an alternative to utilizing the evaluation board tabs. The user can write a command sequence by activating the Macro Recorder indicated by the Macro loading tab in Figure 26.

### 2.4.2 Evaluation Board Tabs

If selected, each EvalBoard gets their own Tab in the MainWindow, which contains all available controls for that particular board. The Tab for the TLE9246x family of devices is structured in 5 main widgets as can be seen in Figure 27.
- Global control
- Channel widgets
- Diagnostics
- SPI register widget

Figure 27    Example TLE92466 GUI Tab
To configure the evaluation boards with the GUI, the following sequence is recommended:

- Reset the Chip by unchecking and the re-checking RESN via GlobalControl.
- Set appropriate channel settings in the CHx registers.
- Activate needed channels in Central -> CH_CTRL register.
- Activate MissionMode in the Central -> CH_CTRL register.
- Enable the Chip by setting EN via Global Control.

Additionally, the watchdog value can be modified using the slider on the global control widget. The watchdog is, however, triggered properly at startup and does not need to be configured.

The Diagnostics widget displays the state of the chip’s diagnostic registers, by default, these values don’t update automatically, for this you need to check the AutoUpdate checkbox in GlobalControl.

### 2.5 Information on the GUI communication interface

The GUI software sends commands via UART to the TriBoard based on the User input. The TriBoard microcontroller firmware decodes the commands and executes them accordingly. The following list shows available commands that can be used to directly execute commands with the help of a terminal program.

- All values have to be typed in as hexadecimal numbers. If the first digit is alphabetic, a zero has to be typed in front of the value.
- The Connection-PCB must be initialized on startup. The type of Connection-PCB is displayed on startup or when entering the help() command.
- For most commands a slot number (slot) has to be entered. Slot 0 selects the Connection PCB. The Eval-PCBs are enumerated according to the slot naming shown in figure 11 (Slot A: (1) to Slot C: (3). The XMC1100 has a single slot (1) only.
- Not all Eval-PCBs can be mounted on every slot. The user can initialize Eval-PCBs by the initialization commands and the slot number. The type of initialized Eval-PCBs is displayed when entering the help() command.
- CRCs, Parity Bits or similar have to be calculated by the user.
- The UART interface should be configured as shown in following figure.

![UART setup](image)

**Figure 28**   UART setup

### 2.5.1 List of Commands

- InitEvalNGSD(slot) – NGSD-Connection-PCB (slot 1 or 2), Microcontroller board slot 1.
• help() – help
  Displays board info, names and command list.
  Returns 0 always.

• delay(ticks) - delay
  Waits for ticks time in milliseconds.
  Returns ticks.
  Expected values:
  ▪ ticks: [0x1] to [FFFFFFFF]

• ior(slot, ioDev) - io read
  Returns state of input or output ioDev, if successful.
  Expected values:
  ▪ slot: [0] to [3], depending on the initialized boards
  ▪ ioDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the initialized boards

• iow(slot, ioDev, outState) - io write
  Writes outState to output ioDev.
  Returns outState, if successful.
  Expected values:
  ▪ slot: [0] to [3], depending on the initialized boards
  ▪ ioDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the initialized boards
  ▪ outState: [0] or [1]

• iop(slot, ioDev, outState, ticks) - io pulse
  Sets ioDev to outState for the time of ticks ms, then sets ioDev to inverse outstate.
  Returns ioDev, if successful.
  Expected values:
  ▪ Slot: [0] to [3], depending on the initialized boards
  ▪ IoDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the initialized boards
  ▪ OutState: [0] or [1]
  ▪ Ticks: [1] to [FFFFFFFF]

• iowt(slot, ioDev, inState) - io wait
  Waits until ioDev has the value of instate.
  Returns inState, if successful.
  Expected values:
  ▪ slot: [0] to [3], depending on the initialized boards
  ▪ ioDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the initialized boards
  ▪ inState: [0] or [1]

• spi(slot, spiDev, out) - spi write
  Sends an spi command with content out to device spiDev (normaly 0).
  Returns the return value of the previous command, if successful (previous command can be the watchdog command, if activated).
Expected values:
- slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-Management-Connection-PCB yet
- spiDev: [0]
- out: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB

**spis(slot, spiDev, out1, out2, ticks) - spi sequence**
Sends two spi commands with a delay of ticks ms to device spiDev (normally 0).
Returns the return value of the command before the second command, if successful (watchdog command can be sent between both commands, if activated).
Expected values:
- slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-Management-Connection-PCB yet
- spiDev: [0]
- out: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
- ticks: [1] to [FFFFFFFF]

**spir(slot, spiDev, out, nop) - spi read**
Sends two spi commands in quick succession to device spiDev (normally 0).
In contrast to other spi functions not interrupted by watchdog.
Returns the return value of first command (which is received while sending the second command). Second command can either be a "no operation" value or another command whose answer is not needed.
Expected values:
- slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-Management-Connection-PCB yet
- spiDev: [0]
- out: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
- nop: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
## Revision history

**Major changes since the last revision**

<table>
<thead>
<tr>
<th>Page or Reference</th>
<th>Description of change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>Initial release</td>
</tr>
<tr>
<td>V1.1</td>
<td>Added TLE92466ED layout</td>
</tr>
</tbody>
</table>
Trademarks of Infineon Technologies AG
µHVIC™, µPM™, µPFC™, AU-ConvertIR™, AURIX™, C166™, CanPAK™, CIPOS™, CIJURSE™, CoolDP™, CoolGaN™, COOLIR™, CoolMOS™, CoolSET™, CoolSiC™, DAVE™, DI-POL™, DirectFET™, DrsIle™, EasyIM™, EcoBRIDGE™, EconoDUAL™, EconoPAK™, EiceDRIVER™, eZep™, FCOS™, GaNpowIR™, HEXFET™, HITFET™, HybridPAK™, IMOTION™, IRAM™, ISOFACE™, IsoPACK™, LEDrivIR™, LITIX™, MIPAQ™, ModSTACK™, my-d™, Novalithic™, OPTIGA™, OptiMOS™, ORIGA™, PowiRaudio™, PowiRStage™, PrimePACK™, PrimeSTACK™, PROFET™, PRO-SIL™, RASIC™, REAL3™, SmartLEWIS™, SOLID FLASH™, SPOC™, StrongIRFET™, SupIRBuck™, TEMPFET™, TRENCHSTOP™, TriCore™, UHVIC™, XHP™, XMC™

Trademarks updated November 2015

Other Trademarks
All referenced product or service names and trademarks are the property of their respective owners.

IMPORTANT NOTICE
The information given in this document shall in no event be regarded as a guarantee of conditions or characteristics (“Beschaffenheitsgarantie”).

With respect to any examples, hints or any typical values stated herein and/or any information regarding the application of the product, Infineon Technologies hereby disclaims any and all warranties and liabilities of any kind, including without limitation warranties of non-infringement of intellectual property rights of any third party.

In addition, any information given in this document is subject to customer’s compliance with its obligations stated in this document and any applicable legal requirements, norms and standards concerning customer’s products and any use of the product of Infineon Technologies in customer’s applications.

The data contained in this document is exclusively intended for technically trained staff. It is the responsibility of customer’s technical departments to evaluate the suitability of the product for the intended application and the completeness of the product information given in this document with respect to such application.

For further information on the product, technology, delivery terms and conditions and prices please contact your nearest Infineon Technologies office (www.infineon.com).

WARNINGS
Due to technical requirements products may contain dangerous substances. For information on the types in question please contact your nearest Infineon Technologies office.

Except as otherwise explicitly approved by Infineon Technologies in a written document signed by authorized representatives of Infineon Technologies, Infineon Technologies’ products may not be used in any applications where a failure of the product or any consequences of the use thereof can reasonably be expected to result in personal injury.